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ABSTRACT 

 As technological developments are more advanced and open with the current globalization as 

now, it is expected that advanced technology can provide convenience in all areas, such as measurement and 

temperature monitoring for example. Therefore, it takes a tool that serves to convert the amount of heat into 

a quantity of electricity that can easily be analyzed amount of temperature sensors. This research begins 

with the human body temperature that will be detected by arduino microcontroller temperature sensor. The 

receiver interacts the detection device using the LM35 temperature sensor. The result of the temperature 

change will be read and processed on the arduino microcontroller.In testing the accuracy of body 

temperature value, temperature measurement is done by putting the body temperature sensor LM35di body 

part that is neck, mouth, right armpit, armpit left, chest and back.That The measurement of the temperature 

sensor that is LM35 compared to the thermometer, is able to work well. The percentage error rate of the 

temperature sensor is 0%. According to the LM35 sensor testing compared to a thermometer, having a 

temperature range difference is zero comma, so the results of the measurement are still in tolerance. 
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I PENDAHULUAN 

Seiring dengan perkembangan zaman dan teknologi kebutuhan informasi yang cepat, sangat dibutuhkan 

dalam berbagai bidang. Salah satu kebutuhan informasi tersebut adalah informasi mengenai suhu. Dalam 

pengukuran suhu, suhu tergantung dari faktor eksternal dan faktor internal. Maka dari itu, dibutuhkan alat 

yang berfungsi mengubah besaran panas menjadi besaran listrik yang dapat dengan mudah dianalisis 

besarannya yaitu sensor suhu.  

Sensor suhu melakukan pengukuran terhadap jumlah energi panas/tinggi yang dihasilkan oleh suatu 

objek. Sehingga memungkinkan untuk mengetahui atau mendeteksi gejala perubahan-perubahan suhu 

tersebut. Sensor suhu yang digunakan adalah sensor suhu  IC-LM35 dan perangkat displai hasil pengukuran 

yang digunakan adalah smartphone dengan OS android. Sensor ini adalah pendekteksi perubahan suhu, 

kemudian hasil perubahan suhu akan dibaca dan diproses pada mikrocontroller, setelah data terproses 

selanjutnya data akan dikirimkan keperangkat android melalui koneksi bluetooth. Perkembangan alat deteksi 

yang digunakan adalah sensor suhu IC-LM35 dengan program Arduino. 

Arduino dapat dikatakan sebuah platform dari physical computing yang bersifat open source. Arduino 

tidak hanya sekedar alat perkembangan, kombinasi dari hardware, bahasa pemrograman dan integrated 

Development Environment (IDE) yang canggih. IDE adalah sebuah software yang berperan untuk menulis 

program, meng-compile, menjadi kode biner dan meng-upload ke dalam memori microcontroller. 

Microcontroller adalah sebuah sistem mikroprosesor dimana didalamnya sudah terdapat CPU, Read Only 

Memory (ROM), Random Access Memory (RAM), Input-Output, Timer, Interrupt, Clock dan peralatan 
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internal lainnya yang sudah saling terhubung dan terorganisasi dengan baik dalam satu chip yang siap 

dipakai. 

Program arduino untuk sensor suhu LM35 memungkinkan untuk menuliskan barisan program yang 

dapat membaca data senspr LM35 yang itu mengubah data analog sensor menjadi data digital pada arduino. 

Arduino lebih kompatibel dan fleksibel, sehingga program ketika menyentuh sensor suhu lebih baik  dan itu 

bisa merubah kode scriptnya tanpa membongkar  atau mensolder rangkaian. 

II TINJAUAN PUSTAKA 

2.2.1 Arduino 

 Arduino adalah platform pembuatan prototipe elektronik yang bersifat open-source hardware yang 

berdasarkan pada perangkat keras dan perangkat lunak yang fleksibel dan mudah digunakan. Arduino 

ditujukan bagi para seniman, desainer, dan siapapun yang tertarik dalam menciptakan objek atau lingkungan 

yang interaktif. 

Arduino pada awalnya dikembangkan di Ivrea, Italia. Nama Arduino adalah sebuah nama maskulin 

yang berarti teman yang kuat. Platform arduino terdiri dari arduino board, shield, bahasa pemrograman 

arduino, dan arduino development environment. Arduino board biasanya memiliki sebuah chip dasar 

mikrokontroler Atmel AVR ATmega8 berikut turunannya. 

Arduino tidak hanya sekedar sebuah alat pengembangan, tetapi ia adalah kombinasi darihardware, 

bahasa pemrograman dan Integrated Development Environment (IDE) yang canggih. IDE adalah sebuah 

software yang sangat berperan untuk menulis program, meng-compile menjadi kode biner dan meng-upload 

ke dalam memory microcontroller. Ada banyak projek dan alat-alat dikembangkan oleh akademisi dan 

profesional dengan menggunakan Arduino, selain itu juga ada banyak modul-modul pendukung (sensor, 

tampilan, penggerak dan sebagainya) yang dibuat oleh pihak lain untuk bisa disambungkan dengan Arduino.  

Arduino berevolusi menjadi sebuah platform karena ia menjadi pilihan dan acuan bagi banyak praktisi. 

Software lebih mudah diubah dibandingkan hardware, dengan beberapa penekanan tombol kita dapat 

merubah logika alat secara radikal dan mencoba versi ke-dua, ke-tiga dan seterusnya dengan cepat tanpa 

harus mengubah pengkabelan dari rangkaian. Salah satu yang membuat Arduino memikat hati banyak orang 

adalah karena sifatnya yang open source, baik untuk hardware maupun software-nya.  

Arduino Uno adalah arduino board yang menggunakan mikrokontroler ATmega328. Arduino Uno 

memiliki 14 pin digital (6 pin dapat digunakan sebagai output PWM), 6 input analog, sebuah 16 MHz 

osilator kristal, sebuah koneksi USB, sebuah konektor sumber tegangan, sebuah header ICSP, dan sebuah 

tombol reset. Arduino Uno memiliki area cakupan yang luas untuk segala hal yang dibutuhkan untuk 

mendukung sebuah aplikasi yang berbasiskan mikrokontroler. Hanya dengan menghubungkannya ke sebuah 

komputer melalui USB atau memberikan tegangan DC dari baterai atau adaptor AC ke DC sudah dapat 

membuat aplikasinya bekerja. Arduino Uno menggunakan ATmega16U2 yang diprogram sebagai USB-to-

serial converter untuk komunikasi serial ke komputer melalui port USB. 

2.2.2 Sensor LM35 

Sensor merupakan jenis tranduser yang digunakan untuk mengubah besaran mekanis, magnetis, panas, 

sinar, dan kimia menjadi tegangan dan arus listrik. Sensor sering digunakan untuk pendeteksian pada saat 

melakukan pengukuran atau pengendalian. Beberapa jenis sensor yang banyak digunakan dalam rangkaian 

elektronik antara lain sensor cahaya(LDR),sensor suhu(LM35), dan sensor kelembaban uadara(DHT11). 

Dalam melakukan analisa ini digunakan sensor tipe LM35 yang digunakan sebagai alat sensor suhu 

didalam rangkaian dengan menggunakan supplay tegangan sebesar 0-5V dari Arduino yang merupakan 

board elektronik atau papan rangkaian elektronik open source yang di dalamnya terdapat komponen utama 

yaitu sebuah chip mikrokontroler dengan jenis AVR dari perusahaan Atmel.Mikrokontroler itu sendiri adalah 

chip atau IC (integrated circuit) yang bisa diprogram menggunakan komputer. Tujuan menanamkan program 
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pada mikrokontroler adalah agar rangkaian elektronik dapat membaca input, memproses input tersebut dan 

kemudian menghasilkan output sesuai yang diinginkan. 

Mikrokontroler juga dipakai untuk keperluan mengendalikan robot. Baik robot mainan, maupun robot 

industri. Untuk mendeteki keadaan alam sekitar berupa data hasil analog input yang dibaca oleh sensor maka 

dibawah ini terdapat beberapa dasar teori yang menjadi acuan untuk mengenal cara kerja sensor yang 

digunakan dalam penelitian ini adalah sebagai berikut : 

2.2.2.1 Sensor suhu / Temperature (LM35) 

Karena komponen utama Arduino adalah mikrokontroler, maka Arduino pun dapat diprogram 

menggunakan komputer sesuai kebutuhan kita. untuk dapat mengukur suhu ruangan dibutuhkan satu 

komponen saja yaitu LM35.  

Selain modul mikrokontroler Arduino.LM35 adalah sensor suhu dari National Semiconductor yang 

mempunyai akurasi tinggi.  Outputnya berupa tegangan analog dan memiliki jangkauan pengukuran -55ºC 

hingga +150ºC dengan akurasi ±0.5ºC. Tegangan output adalah 10mV/ºC.   

Output dapat langsung dihubungkan port mikrokontroler yang memiliki ADC atau dengan Arduino, 

karena Arduino memiliki port ADC (analog input) sebanyak 6 buah. kemudian rangkaian modul Arduino 

dengan sensor suhu seperti gambar di bawah ini : 

 

 

 

 

 

 
 

Gambar 1 Sensor suhu/Temperature (LM35) 

2.2.3 Android 

Android  adalah software besutan Google yang mencakup sistem operasi atau OS, middleware, dan 

aplikasi kunci yang berbasis Linux pada suatu gadget seperti telephone cellular, smartphone dan komputer 

tablet. Android persis seperti symbian yang dipergunakan oleh Nokia dan BlackBerry OS. Jelasnya seperti 

microsoft windows yang sangat dikenal baik oleh para pengguna komputer dan laptop. Jika dianalogikan, 

Android adalah windows-nya sedangkan smartphone atau komputer tablet adalah unit komputernya. 

Android menyediakan platform terbuka (open souces) bagi para pengembang untuk menciptakan 

aplikasi mereka sendiri untuk digunakan oleh berbagai macam piranti bergerak. Awalnya, Google Inc. 

membeli Android Inc., pendatang baru yang membuat piranti lunak untuk ponsel. Kemudian Google Inc 

mengembangkannya dengan cara membentuk Open Handset Alliance (OHD), konsorsium dari 34 

perusahaan peranti keras, peranti lunak, dan telekomunikasi, termasuk Google, HTC, Intel, LG, Motorola, 

Qualcomm, T-Mobile, Samsung dan Nvidia. 

Di dunia ini terdapat dua jenis distributor sistem operasi Android. Pertama yang mendapat dukungan 

penuh dari Google atau Google Mail Services (GMS) dan yang kedua adalah yang benar–benar bebas 

distribusinya tanpa dukungan langsung Google atau dikenal sebagai Open Handset Distribution. Keputusan 

Google Inc. mengembangkan Android dengan cara membentuk Open Handset Distribution dinilai sangat 

tepat karena melalui hal tersebut saat ini Android telah berhasil menjadi salah satu sistem operasi paling 

populer. Saking populernya Android pun dapat mengalahkan sistem operasi lain seperti iOS, Windows 

Phone, dan Blackberry. 

Dengan sistem distribusi open sources yang digunakan Android, memungkinkan para pengembang 

untuk menciptakan berbagai macam aplikasi menarik yang dapat dinikmati oleh para penggunanya, seperti 

http://www.indorobotika.com/arduino
http://www.indorobotika.com/arduino
http://id.wikipedia.org/wiki/Sistem_operasi
http://id.wikipedia.org/wiki/Linux
http://id.wikipedia.org/wiki/Komputer_tablet
http://id.wikipedia.org/wiki/Komputer_tablet
http://id.wikipedia.org/wiki/Komputer_tablet
http://id.wikipedia.org/w/index.php?title=Open_Handset_Alliance&action=edit&redlink=1
http://id.wikipedia.org/wiki/Google
http://id.wikipedia.org/wiki/HTC
http://id.wikipedia.org/wiki/Intel
http://id.wikipedia.org/wiki/Motorola
http://id.wikipedia.org/wiki/Qualcomm
http://id.wikipedia.org/wiki/T-Mobile
http://id.wikipedia.org/wiki/Nvidia
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game, chatting dan lain-lain, hal ini pulalah yang membuat smartphone berbasis Android ini lebih murah 

dibanding gadget sejenisnya. 

 

III METODE PENELITIAN 

3.1. Analisis Kebutuhan Perangkat Lunak 

3.1.1. Kebutuhan Perangkat Lunak 

Perangkat lunak yang dibutuhkan untuk membangun aplikasi ini adalah : 

a. Sistem operasi Windows 7 ultimate 32bit 

b. Arduino IDE 1.8.1 

c. Pemrograman android app inventor 

3.1.2. Kebutuhan Perangkat Keras 

Perangkat keras yang dibutuhkan untuk membangun aplikasi ini adalah : 

1. Komputer/laptop 

2. Smartphone android 2.0 

3. Arduino  

4. Modul Bluetooth HC.05 

5. Sensor LM35 

6. Kabel Jumper 

3.2. Perancangan Global Sistem 

 Adapun perancangan global sistem pada penelitian ini sebagai berikut 

 

 

Gambar 3.Rancangan global sistem 

Penjelasan : 

1. Penelitian ini diawali dengan adanya suhu tubuh pada manusia yang akan di deteksi oleh sensor suhu 

mikrokontroller arduino 

2. Selanjutnya, suhu akan di deteksi oleh sensor suhu LM35. 

3. Input dari sensor suhu LM35 akan diteruskan ke arduino untuk di proses ke bluetooth. 

4. Bluetooth HC05 akan mengirimkan nilai hasil sensor untuk dikirimkan ke smartphone. 

5. Smartphone android menerima nilai hasil sensor dan menampilkannya dalam satuan derajad celcius. 

6. Selanjutnya android menyimpan nilai suhu dan merekamnya secara terus menerus 

3.3. Diagram Block Sistem 

Adapun diagram block sistem pada penelitian ini sebagai berikut 

 

 

Gambar 4 Diagram Block Sistem 
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3.4. Flow chart 

Adapun flowchart pada penelitian iniadalah sebagai berikut 

 

 

 

 

 

 

 

Gambar 5 Flow Chart Sistem 

3.5. Rangkaian elektronika 

Adapun rangkaian elektronika  pada penelitian ini adalah sebagai berikut 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 6 Rangkaian Elektronika 

3.6. Use Case 

Use case Diagram merupakan konstruksi untuk mendeskripsikan hubungan - hubungan yang terjadi 

antarauser dengan aktivitas yang terdapat pada aplikasi. Dari hasil analisis aplikasi yang ada maka usecase 
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diagram untuk aplikasi monitoring suhu tubuh menggunakan arduino dengan koneksi bluetooth android 

dapat di lihat pada gambar berikut: 

 

Gambar 3.5 Use Case 

 

 

 

Gambar 7 Use Case 

Gambar diatas berikut ini menjelaskan bagaimana pengguna menggunakan sistem. Pengguna yang 

terdapat di dalam sistem teknik deteksi suhu tubuh dengan menggunakan proses arduino ini adalah 

penerima. Pada bagian penerima dilakukan interaksi alat deteksidengan menggunakan sensor suhu 

LM35. Hasil perubahan suhu akan dibaca dan diproses pada mikrokontroler arduino. Data yang 

terproses, selanjutnya data akan dikirimkan ke perangkat android melalui koneksi bluetooth. 

3.7. Pengujian system 

Adapun pengujian yang akan dilakukan pada penelitian ini sebagai berikut : 

3.7.1. Pengujian akurasi nilai suhu tubuh 

Pada pengujian akurasi nilai suhu tubuh, pengukuran suhu dilakukan dengan meletakkan sensor suhu 

tubuh LM35di bagian tubuh yaitu leher, mulut, ketiak kanan, ketiak kiri, dada dan punggung. Kemudian data 

hasil uji alat pengukur suhu tubuh  di deteksi tanpa kontak fisik ke Arduino. Data nilai suhu tubuh terekam 

pada android melalui bluetooth. 

3.7.2. Pengujian jarak sensor suhu terhadap smartphone android 

Adapun yang dimaksud pengujian ini adalah mengukur jarak panjang smartphone android dengan 

arduino. Jarak yang digunakan yaitu 10 cm, 30 cm, 50 cm, 70 cm, 90 cm,110 cm,130 cm….500 cm 

 

IV HASIL DAN PEMBAHASAN 

Bab ini akan membahas tentang hasil pengujian software  yang telah di buat pada arduino terhadap 

modul bluetooth HC.05. Tujuan dari pengujian ini adalah mengetahui apakah software yang telah dibuat 

sesuai dengan spesifikasi perancangan. Selain juga  untuk mengetahui detail software serta permasalahan 

yang ada agar dapat dilakukan perbaikan dan pengembangan lebih lanjut. 

4.1 Perangkat Keras ( Hardware ) 

Perangkat keras ( Hardware ) yang digunakan pada percobaan ini adalah sebagai berikut : 

1. Komputer/laptop 

2. Smartphone android 2.0 

3. Arduino  

4. Modul Bluetooth HC.05 

5. Kabel USB 
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4.2  Perangkat Lunak ( Software ) 

Sedangkan untuk spesifikasi perangkat lunak yang digunakan adalah sebagai berikut : 

1. Sistem Operasi Windows 7 ultimate 32 bit 

2. Arduino IDE 1.8.1 

3. Skrip Modul Bluetooth HC.05 

4.3 Sistem pembuatan/development 

4.3.1 Install Software IDE 1.8.5 Arduino 

Setelah berhasil mengunduh file installer ,double click file tersebut untuk segera memulai proses 

instalasi. 

1. Setelah file installer dijalankan, akan muncul jendela „Licence Agreement‟. Klik tombol „I Agree‟ 

 

 

 

 

 

Gambar 8 Proses Instalasi Software IDE 1.8.5 Arduino 

2. Berikutnya masukkan folder instalasi arduino. Biarkan default di C:\Program Files\Arduino. 

 

 

 

 

 

 

 

Gambar 9 Installation Folder 

3. Setelah itu muncul jendela „Setup Installation Options‟ centang semua pada opsinya  
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Gambar 11 Setup Installation Folder 

4. Selanjutnya proses instalasi akan dimulai 

 

 

 

 

 

Gambar 12 Installing Proses 

5. Di tengah proses instalasi, jika komputer belum terinstal driver USB, maka akan muncul jendela „Security 

Warning‟.Pilih tombol „install‟ 

 

 

 

 

Gambar 13Jendela Windows Security 

6. Tunggu sampai proses instalasi „Completed‟ 
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Gambar 14 Installing Complete 

7. Pada tahap ini software IDE Arduino sudah terinstal. Cek di start Menu Windows atau dekstop akan 

muncul ikon Arduino.Jalankan aplikasinya dan akan muncul splash screen seperti gambar dibawah ini : 

 

 

 

 

 

 

 

Gambar 15 Arduino IDE 

8. Beberapa detik kemudian, jendela IDE Arduino akan muncul   

 

 

 

 

 

 

 

 

 

Gambar 16 Jendela Arduino IDE 

9. Konfiguras Arduino dengan software  

1. Hubungkan port USB pada Arduino dengan Laptop 

2. Klik 2 kali pada aplikasi Arduino  

3. Buka contoh Blink : File > Example > 1.Basic > Blink. 



 

 

Jurnal Explore IT | 33 

 

 

 

 

 

 

 

 

 

 

Gambar 17 Konfigurasi Arduino dengan software 

4. Pilih Board pada menu Tools > Board yang sesuai dengan board Arduino yang dipakai. 

 

 

 

 

 

 

 

Gambar 18 Board Arduino IDE 

5. Pilih serial port  digunakan oleh board Arduino pada menu Tools > Serial Port. Pilih COM3 atau yang 

lebih tinggi (COM1 dan COM2  sudah direservasi untuk serial port hardware). Untuk mencari tahu, dapat 

melepaskan koneksi ke board Arduino dan buka kembali menu tadi; pilihan yang menghilang harusnya 

adalah board Arduino. Koneksikan kembali board-nya dan pilih serial port yang sesuai. 

6. Upload program 

 Klik tombol “Upload” pada software. Tunggu beberapa saat lihat led TX dan RX pada board berkelap-kelip. 

Bila upload berhasil akan ada pesan “Done uploading.” yang muncul pada status bar. 

 

Gambar 19 Tampilan Upload Software 
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Beberapa saat setelah upload selesai, anda dapat melihat pin 13 (L) LED pada board mulai berkelap-kelip 

(warna oranye). Jika benar, maka berhasil menjalankan Arduino dan program-nya dengan sukses. 

4.4 Aplikasi android 

Adapun aplikasi android yang dibuat pada penelitian ini menggunakan app inventor. Berikut ini adalah 

layout tampilan aplikasinya: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 20 Layout Aplikasi Android 

Penjelasan gambar 4.14 : 

 SCAN,  digunakan apabila Bluetooth belum terdeteksi 

 Connected,  jika Bluetooth handphone telah tersambung ke modul hardware dan terhubung ke 

aplikasi sensor suhu 

 Disconnect,  apabila koneksi Bluetooth tidak terhubung atau belum dinyalakan. 

 Suhu Saat Ini, proses akhir jika Bluetooth telah tersambung pada aplikasi sensor suhu dan data 

suhu terlihat. 
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Adapun Skrip app inventor yang digunakan adalah sebagai berikut : 

 

 

 

 

 

Gambar 21Skrip App inventor 

4.5  Pengujian Alat 

Adapun pengujian yang akan dilakukan pada penelitian ini sebagai berikut : 

4.5.1 Pengujian akurasi nilai suhu tubuh 

Pada pengujian akurasi nilai suhu tubuh, pengukuran suhu dilakukan dengan meletakkan sensor suhu 

tubuh LM35 di bagian tubuh yaitu leher, mulut, ketiak kanan, ketiak kiri, dada dan punggung. Kemudian 

data hasil uji alat pengukur suhu tubuh  di deteksi tanpa kontak fisik ke Arduino. Data nilai suhu tubuh 

terekam pada android melalui Bluetoot 

 

Tabel 1 Data Nilai Suhu Tubuh 

 

 

 

 

 

4.5.2 Pengujian jarak sensor suhu terhadap smartphone android 

Adapun yang dimaksud pengujian ini adalah mengukur jarak panjang smartphone android dengan 

arduino. 

Tabel 2 Jarak Sensor Suhu terhadap Smartphone Android 

No Bagian Tubuh Suhu(celcius) 

1 Leher 35 

2 Mulut 36 

3 Ketiak kanan 37 

4 Ketiak kiri 37 

5 Dada 33 

6 Punggung 35 

No Jarak (cm) 
Koneksi ke 

Android 

1 10 berhasil 

2 20 berhasil 
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4.6.2 Pengujian akurasi sensor suhu dengan 

termometer 

Adapun yang dimaksud pengujian ini adalah 

membandingkan keakurasian nilai sensor suhu dengan 

termometer. 

Tabel 3 Akurasi sensor suhu dengan termometer  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

V KESIMPULAN DAN SARAN 

 

5.1. Kesimpulan 

Berdasarkan Implementasi dan hasil pengujian dapat diambil kesimpulan sebagai berikut: 

1. Smartphone bisa terhubung dan memberi perintah pada Modul Bluetooth melalui konektivitas Bluetooth 

dan menghasilkan data suhu tubuh manusia 

2. Penelitian ini merupakan hasil pengembangan dari penelitian sebelumnya dimana menggunakan media 

jaket dan handphone untuk mengontrol suhu tubuh. Penelitian ini dilakukan dengan menggunakan 

sensor  sebagai pendeteksi perubahan suhu tubuh yang kemudian hasil perubahan suhu akan dibaca dan 

diproses pada mikrokontroler ATMega8a-pu. Data yang terproses, selanjutnya data akan dikirimkan ke 

perangkat android melalui koneksi bluetooth. 

3. Modul Bluetooth HC.05 dapat digunakan untuk mengidentifikasi sensor Bluetooth dengan baik dan 

dalam pembuatan aplikasi sensor suhu 

 

 

5.2. Saran 

Adapun saran dari penyusun skripsi untuk dapat melakukan pengembangan selanjutnya adalah : 

1. Sistem aplikasi sensor suhu pada penelitian ini membahas koneksi Bluetooth yang terhubung ke module 

bluetooth dengan mempertimbangkan jarak ukur, apabila handphone berada pada jarak tertentu, dalam 

hal ini jarak 8 meter koneksi terputus.Untuk selanjutnya dapat dikembangkan. 

2. Sistem aplikasi sensor suhu pada penelitian ini dalam penyimpanan data hanya terbatas pada suhu 

terakhir yang terdeteksi. Untuk penelitian selanjutnya dapat dikembangkan dengan memberikan rekam 

data tersimpan pada smartphone, sehingga pengecekan suhu  tubuh dapat terkontrol dengan baik. 

3 30 berhasil 

4 40 berhasil 

5 50 berhasil 

6 60 berhasil 

7 70 berhasil 

8 80 berhasil 

9 90 berhasil 

10 100 berhasil 

11 200 berhasil 

12 300 berhasil 

13 400 berhasil 

14 500 berhasil 

15 800 Tidak berhasil 

No 
Bagian 

Tubuh 

Sensor 

suhu 

(celcius) 

Termometer 

(celcius) 

1 Leher 35 35,6 

2 Mulut 36 36,4 

3 
Ketiak 

kanan 
37 37 

4 Ketiak kiri 37 37 

5 Dada 33 32,5 

6 Punggung 35 35,5 
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